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What this exercise is about 

The objective of this lab is to provide you with an understanding of WebSphere Adapter for FTP and 
inbound event processing. In this lab you will deploy the WebSphere Adapter for FTP, using WebSphere 
Integration Developer, and integrate it with an SCA application that polls for inbound events and processes 
those inbound requests from the file system. 

Lab requirements 

List of system and software required for the student to complete the lab. 

• WebSphere Integration Developer V6.1 installed and updated with latest fixes 

• WebSphere Process Server V6.1 Test Environment installed and updated latest fixes 

• Extract LabFiles61.zip to your C:\ (your root) drive 

What you should be able to do 

At the end of this lab you should be able to: 

• Import FTP adapter RAR file into WebSphere Integration Developer 

• Use External Service wizard to configure  Activation Spec Properties, Resource Adapter Properties to 
generate Business Objects and other artifacts and then configure Function Selector, Data Binding and 
Data Handlers 

• Deploy the adapter application onto WebSphere Process Server 

• Test the deployed application using WebSphere Process Server test environment for both pass-
through and non pass-through using different scenarios and patterns 

• Restore the server configuration 
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The backend EIS is the source of events. When events are generated at the EIS, files are created by 
the EIS in the remote file system at a specific directory location. The same directory needs to be 
configured by you as the Event Directory for the adapter. 

The adapter polls event files, based on configured Event File Mask and FTP Get Quantity, from the Event 
Directory and downloads to a Local Event Directory in the adapter machine for every FTP Poll Frequency 
time and archives the file in FTP Archive Directory of the FTP server (it specified by you).  

The adapter splits the downloaded event files from Local Event Directory based on the configured 
SplittingFunctionClassname (splitting functionality) and SplitCriteria (splitting criteria used). User can 
implement his/her own class which contains the splitting logic which splits the event files into individual 
Business Objects. The adapter provides a Java™ interface which you have to implement in a class. 

An entry is made in the Event Persistence table (given by EPEventTableName) for each BO with status as 
New Event. The adapter sends the record chunk, through a Function Selector and Data Binding, to the 
endpoint and the status in the Event Persistence table is updated based on successful (to PROCESSED 
state) or failed(to FAILED state) delivery to the endpoint. The event management framework takes care of 
delivering the event only once to the endpoint. 

If archiving is enabled (if LocalArchiveDirectory has a valid value), the Business Objects are also archived 
in a configured Local Archive Directory, on the local file system, based on successful or failed delivery to 
the endpoint. Successful and failed events are written to different files. The entries from the Event 
Persistence table are deleted for each of the successfully processed BO’s only. If Local ArchiveDirectory is 
not set, the event file is deleted after processing of all the BO’s is completed. 

If EventContentType in the Activation Spec Properties is not set or if it is not valid or the value does not 
match the entries present in annotation of the Wrapper data object then it is called PassThrough and data 
transformation will not happen in this case. During PassThrough the SplittingFunctionClassName and 
SplitCriteria are set to values (even if they are set to different values) such that splitting happens based on 
file size. In the PassThrough scenario you can have either Chunking or FilePassbyReference features. 

 

Exercise instructions 

Some instructions in this lab are Windows operating-system specific.  If you plan on running the lab on an 
operating-system other than Windows, you will need to run the appropriate commands, and use 
appropriate files ( .sh or .bat) for your operating system.  The directory locations are specified in the lab 
instructions using symbolic references, as follows: 
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Reference variable Windows ® location AIX® or UNIX® 
location 

<WID_HOME> C:\Program Files\IBM\WID61  

<FTPADAPTER_HOME> <WID_HOME>\ResourceAdapters\FTP_6.1.0.0\deploy  

<LAB_FILES> C:\Labfiles61 /tmp/Labfiles61 

<WORKSPACE> <LAB_FILES>\FTPInbound\workspace  

<LOCAL_EVENT_DIR> <LAB_FILES>\FTPInbound\LocalEventDir  

<LOCAL_ARCHIVE_DIR> <LAB_FILES>\FTPInbound\LocalArchivetDir  

<FTPFILES> <LAB_FILES>\FTPFiles  

<TEMP> C:\temp /tmp 

Windows users’ note : When directory locations are passed as parameters to a Java program such as 
EJBdeploy or wsadmin, it is necessary to replace the backslashes with forward slashes to follow the Java 
convention. For example, replace C:\LabFiles61\ with C:/LabFiles61/. 

 

Instructions if using a remote server for testing 

Note that the previous table is relative to where you are running WebSphere Integration Developer.  The 
following table is related to where you are running the remote test environment: 

Reference variable Example: Remote 
Windows test server 

location 

Example: Remote 
z/OS® test server 

location 

Input your values for the 
remote location of the test 

server 

<SERVER_NAME> server1 sssr011  

<WAS_HOME> C:\Program 
Files\IBM\WebSphere\AppServer 

/etc/sscell/AppServer  

<HOSTNAME> localhost mvsxxx.rtp.raleigh.ibm.com  

<SOAP_PORT> 8880 8880  

<TELNET_PORT> N/A 1023  

<PROFILE_NAME> AppSrv01 default  

<USERID> N/A ssadmin  

<PASSWORD> N/A fr1day  

 

Instructions for using a remote testing environment, such as z/OS, AIX or Solaris, can be found at the end 
of this document, in the section “Task: Adding remote server to WebSphere Integration  Developer 
test environment ”.  
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Part 1: Initialize the workspace and prepare for th e lab 

This part of the lab, you will start the WebSphere Integration Developer V6.1 with a new workspace and 
create required data source and database using the administrator console of WebSphere Process Server 
V6.1 

____ 1. Extract the provided LabFiles61.zip to your C:\ (root) drive, if you have not already done so.  This 
will create the necessary subdirectory structure to complete the lab, and provides you with sample 
text files 

____ 2. Start the WebSphere Integration Developer V6.1 with a new workspace 

__ a. Select Start > Programs > IBM Software Development Platfor m > IBM WebSphere 
Integration Developer > IBM WebSphere Integration D eveloper  

__ b. From the Workspace Launcher window, enter <WORKSPACE>  for the Workspace field 

 

____ 3. Click on the  button on the right corner to close the Welcome page and proceed with the 
workbench 

____ 4. Follow the instructions of WBIV61_IEA_ConfigureDatasourceTask  lab with these inputs and 
create the data source and data base required for this lab: 

__ a. Data source name: FTP 

__ b. JNDI name: jdbc/FTP  

__ c. Database name: FTPDB 

____ 5. Create directory structure on your FTP Server 

__ a. Log onto FTP machine/FTP Server using your ftp user and its password 

__ b. Create an EventDir  and an ArchiveDir  under the user’s home directory: 

1) mkdir EventDir 

2) mkdir ArchiveDir 
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Part 2: Pass through scenario 

Inbound support can be broadly classified into two flows, one that involves data transformation and 
another without it (pass-through). In this part of the lab, you will configure the pass through scenario using 
the new External Service option from the WebSphere Integration Developer and then test the configuration 
with different cases.  

Pass through flow for the inbound scenario: 

 

 

• Event data is picked from the event file based on SplitCriteria (it takes a value in bytes), converted 
into a Input Stream and set on FTPInputStreamRecord.  

• The protocol specific information like event file name, directory name are also set in the 
FTPInputStreamRecord. If the PassThrough has a chunk file or if it is FilePassByReference or 
default one is also indicated.  

o In case of FilePassByReference the directory name corresponds to LocalArchiveDirectory 
and file name to event file name appended with timestamp. 

o In case of chunking the directory name indicates LocalEventDirectory, file name 
represents event file name and ChunkInfo represents the chunk details.  

o In case of normal PassThrough the directory name indicates LocalEventDirectory and file 
name represents the event file. 
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• If the databinding does not contain information about the datahandler, then the inbound scenario is 
considered as PassThrough.  

• The FTPInputStreamRecord is sent to the base class and from there to the Function Selector. If no 
matching DataBinding defined or the invoked DataBinding can not resolve to a BO, no content-
specific data binding is invoked but UnstructuredContent SDO is instantiated. It is set with byte 
content present in the input stream object. 

• Optionally the FTPFile wrapper is set with protocol specific information and UnstructuredContent is 
set in FTPFile 

• FTPFile wrapper is directly sent to the endpoint or the wrapper data object is set in FTPFileBG and 
sent to the endpoint in case you want to use Business Graphs 
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2.1. Configure pass through using external service wizard 

In this part of the lab you will use this new external service feature to create and configure the function 
selector, data binding and other required artifacts to test the inbound pass through scenario 

____ 1. Create the module: FTPPSInboundModule 

__ a. From the Business Integration window, right-click and select New > Module  

__ b. From the New Module window, enter FTPPSInboundModule  for the Module Name 

 

__ c. Ensure that the box next to Open module assembly diagram  is checked and then click Finish  

You will now see a new module, FTPPSInboundModule, created from your Business Integration window 

____ 2. To start External Service from the Palette: 

__ a. From the Palette  on the left side of Assembly Diagram, click on Inbound Adapters : 

 

__ b. Under Inbound Adapters, click on the FTP and then click on the empty canvas of the assembly 
diagram. The New FTP File Service wizard is opened 
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____ 3. From the FTP Service screen, select Create a service (advanced)  

 

__ a. Click Next 

Note: You can also start the External Service from the File menu  option: 

From the main menu, select File > New > External Service . This opens an External Service wizard that 
helps you obtain a service which establishes connectivity with other systems. The wizard provides three 
connectivity options – Adapters, Registers, and Messaging  
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Select the radio button next to Adapters  and click Next 

   

____ 4. On the Select an Adapter screen, select IBM WebSphere Adapter for FTP (IBM : 6.1.0.0_IF03)  
and click Next  

 

____ 5. Adapter Import screen: 

In this step, you will import a connector resource adapter archive from the file system into your WebSphere 
Integration Developer workspace. The adapter RAR file already exists under <FTPADAPTER_HOME>. 

__ a. The default Connector file is selected which is shipped along with WebSphere Integration 
Developer 

__ b. Accept the default name for Connector project, CWYFT_FTPFile . You can change it to any other 
name, but for this lab, you can leave the default name. 

__ c. For Target server, ensure that WebSphere Process Server v6.1  is selected 
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__ d. Click Next  

Note : The resource adapter archive file is imported and a new connector project, CWYFT_FTPFile , is 
listed under Business Integration view. 

 

Note : If you are using the File menu  option to start the External Service wizard, you are asked to select 
the Processing Direction  at this point. Select the radio button next to Inbound  and click Next  to proceed 
to the next step. 

____ 6. Service Configuration Properties: 

__ a. Deploy connector project: ensure that the default option With module for use by single 
application  is selected 

__ b. Enter these for FTP system connection information: 

1) Host name: <FTP_Machine_Name>  (or IP Address of the machine that has FTP Server), 
for Ex: wsbeta181.austin.ibm.com 

2) Remote directory: full path of the EventDir created in on the machine  where FTP 
server is existing  (for Ex: /home/wsbeta/EventDir) 

Note : This is the directory from where adapter gets the event files 

3) Local directory: <LOCAL_EVENT_DIR>  

4) Port number: 21 (default) 

5) Protocol: FTP (default) 
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__ c. Click on Advanced >>  to see the hidden advanced properties that can be configured: 

 

You can click on each of the configuration and review the options available under it. For this lab, you will 
need only some of these properties. 

__ d. Event polling configuration:  This has all the polling configuration details and for this lab, you can 
accept the defaults. 

__ e. Event delivery configuration: 

1) Ensure once-only event delivery :  You should check this box only if you are using data 
source and table name in the Event persistence configuration (below). If this property is set 
to true, while using in-memory capability (explained below), the adapter will log a warning 
message. By default this is selected and you can accept the default selection. 

__ f. Event persistence configuration: 

1) Ensure that the Auto create event table  is checked  

2) Event recovery table name: FTPPSTABLE  

3) Event recovery data source (JNDI) name: jdbc/FTP  
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Note : This represents the JNDI name of the Data Source used by Event Persistence to get the JDBC 
database connection. The Data Source must be created in the WebSphere Process Server. You should 
enter the data source JNDI name that you created in Step 3 of Part 1. 

 

Note : The Event recovery data source (JNDI) name is not mandatory  in V6.1. Now, the adapter can use 
in-memory representation  of event table to store all the necessary information. Adapter uses this feature 
when event database information is not configured during inbound event polling. This feature will not 
support the capability of handling “Ensure once-only event delivery”.  

__ g. Advanced connection properties: 

1) User name: username using which you connect to your FTP server  (for Ex: wsbeta) 

2) Password: password for the above user to connect to your FTP server  

3) Pass only file name and directory, not the content (FilePassByReference) : Accept the 
defaults. This property determines if the adapter needs to load the contents of the file or 
just provide information on the directoryName and fileName. If the value is true, the 
adapter just provides the directory name and file name. This is not selected  by default . 

4) Include business object delimiter in the file conte nt (IncludeEndBODelimiter) : Accept 
the defaults. When this property is set to true (selected) the delimiter (given in Split criteria) 
is appended to the BO content before further processing is done. This property is valid only 
if you are splitting the event files based on a delimiter, that is., only if the Split function 
class name (below) is com.ibm.j2ca.utils.filesplit.SplitByDelimiter. This is not selected  by 
default . 

5) Split function class name : Accept the defaults. This value takes a fully qualified class 
name of the class to be used in order to split the event file.  It takes two values as of now: 

• com.ibm.j2ca.utils.filesplit.SplitBySize : a class which splits the event file based 
on event file size. This is the default  value for the split function class name. 

• com.ibm.j2ca.utils.filesplit.SplitByDelimiter : a class which splits the event file 
based on delimiter(used to separate BO’s in event file) 

The delimiter or file size is specified in split criteria attribute. 

6) Specify the criteria to split file content : Accept the defaults. This attribute takes different 
values based on value set in Split function class name.  

• If split function class name is set to com.ibm.j2ca.utils.filesplit.SplitBySize , then 
split criteria must contain a valid number which represents the size in bytes. If 
event file size is greater than this value, it is split into chunks of this value and so 
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many chunks are posted. If event file size is less than this value the entire event 
file is posted in one shot. When split criteria=0 (default ), chunking is disabled. 

• If split function class name is set to 
com.ibm.j2ca.utils.filesplit.SplitByDelimiter , then split criteria must contain the 
delimiter which separates the BO’s in the event file.  

Note : You will use the SplitByDelimiter class later in the content specific scenario. 

 

__ h. FTP archiving configuration: 

1) Local Archive directory: click on Browse…  and select <LOCAL_ARCHIVE_DIR>  
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2) Remote archive directory: full path of the ArchiveDir created in on the machi ne where 
FTP server is existing  (for Ex: /home/wsbeta/ArchiveDir) 

 

____ 7. For this lab, you are not going to use the J2C authentication. So, uncheck  the box next to Specify 
a Java Authentication and Authorization Services (J AAS) alias security credentials . 

 

Function Selector Configuration : Function Selectors are required in order to map between events 
generated by resource adapters and the appropriate SCA export function name. 

There are two function selectors provided by the adapter foundation classes that are supported by the FTP 
adapter - FilenameFunctionSelector and EmbeddedNameFunctionSelector.  

FilenameFunctionSelector is used for generic FTP business object, where the object name cannot be 
determined from the event file The FilenameFunctionSelector is a rule-based function selector that can 
match a regular expression on a file name to an object name.   This is represented in properties as a 2-
column table, with N rows. So, you can have a mapping as follows: For any event file with a .txt extension, 
the corresponding object name is FTPBG. The endpoint method name generated by the function selector 
in this case is emitFTPBG. You need to set this same name in the Native method property after you add 
the operation.  

You can also have same rules multiple times. If more than one rule matches, the function selector will 
return the object name based on the first matching rule.  

The function selector can be configured with multiple “rules”, each of which contains an object name, and 
a regular expression to match against the file name. In the next part of this lab, you will create three such 
rules. 

____ 8. Under Service properties, for Function selector, select Use a function selector configuration  from 
the drop down menu 

Note : If you select Use default function selector ‘FilenameFunctionSele ctor’  option for the Function 
selector, the adapter automatically creates a function selector with FilenameFunctionSelector as the class 
name. But, for this lab, you need to define three rules at the function selector and so you need to use the 
‘Use a function selector configuration’  option. 

____ 9. Click on New next to Function selector configuration. The Resource Configuration window is 
opened 
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__ a. Ensure that the selected module is FTPPSInboundModule  

__ b. For Name, enter any string. For Ex: GenericFS  

 

__ c. Click Next  

____ 10. In the next ‘Select a configuration type’ screen, accept the default Function Selector Class Name, 
com.ibm.j2ca.extension.emd.runtime.FilenameFunction Selector  : 
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__ a. Click Next  

____ 11. Define Function selector rules : In this step, you will define three different rules and object names 
associated with those rules.  

When the adapter gets an event file, the function selector looks at the file type (ex: .txt, .tmp) and if 
the type matches with any of the rules defined in this table, it will associate the corresponding 
Object name of that rule to that event file. 

Object Name  Rule Operation Name EIS function name = emit + Object Name  

FTPBG .*txt emitFTPFileBG emitFTPBG 

FTPType1 .*txt1 emitFTPFile1 emitFTPType1 

FTPType2 .*txt2 emitFTPFile2 emitFTPType2 

Note : Make a note of the Object name you specify here as you are going to use this in the later part 
of the lab while specifying the EIS function name . 

__ a. Click on Add…  next to the Function selector rules table 

__ b. From the Add/Edit pop-up window, enter these: 

1) Object name: FTPBG 

2) Rule: *.txt  

 

Note : You have now created a rule for the files of type .txt  and an Object name, FTPBG, corresponding to 
those file type 

3) Click Finish  from Add/Edit window 

__ c. The above created rule is populated under Function selector rules: 

 

__ d. Repeat Steps 9.a and 9.b to add these function selector rules: 

Object name Rule 

FTPType1 *.txt1 

FTPType2 *.txt2 

__ e.  
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__ f. You should see these three rules: 

 

__ g. Click Finish  

____ 12. You will now be back to External Service window and the function selector created in the above 
steps is populated: 

 

____ 13. You can define data binding in two places - service level (current screen of External Service wizard) 
or later at the method level (Operations screen of the External Service wizard). In this lab, you will 
define data binding at the service level (from this screen) 

__ a. From the dropdown menu next to Data binding, select ‘Use a data binding configuration for all 
operations ’ 

 

__ b. Click New… next to Data binding configuration . A Resource Configuration window is opened. 

__ c. Ensure that the selected module is FTPPSInboundModule  

__ d. For the Name, enter any string, for Ex: FTPPSDB 

 

__ e. Click Next  

__ f. Accept the default data binding Class Name, 
com.ibm.j2ca.ftp.emd.runtime.FTPFileBaseDataBinding  and click Next  

__ g. For pass through, you do not need to configure any data handler. So, click Finish  on this screen 
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__ h. Now the FTPPSDB is displayed for Data binding configuration : 

 

____ 14. Check the box next to Change logging properties for wizard  to view the output location of the log 
file and the logging level. You can change the logging level using the drop down menu. 

____ 15. Click Next  

Following screen is the Operations screen where you can define all your operations.  

In V6.1, you can select from three different Data types for any operation:  

• User defined type 

• Generic FTP business object 

• Generic FTP business object with business graph 

The pass through scenario of this lab demonstrates the creation of three operations (for the three rules you 
have defined in the previous steps) using the Generic FTPFile business object and Generic FTPFile business 
object with business graph data types.  

Add emitFTPFileBG Operation : 

____ 16. From the Operations screen, click on Add…   

__ a. Add Operation window is opened. Select Generic FTP business object with business graph 
for the Data type and click Next  

 

You are now back to Operation window and because you have chosen the data type with business 
graph, the Data type is populated as FTPFileBG  

__ b. For Operation name, enter any name, for Ex: emitFTPFileBG  

__ c. Accept the default Data type, FTPFileBG  

__ d. For Data binding , select Use a data binding configuration  from the dropdown list 

__ e. Define Data Binding type configuration: 

1) Click Browse…  next to Data binding configuration . A Data Binding Selection window is 
opened. 
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2) Select FTPPSDB under Matching data bindings list and click OK 

__ f. Now the FTPPSDB is displayed for Data binding configuration  in the Add Operation window: 

 

__ g. Click Finish . The above defined operation, emitFTPFileBG , is populated under Operations list 

 

Add emitFTPFile1 Operation : 

____ 17. From the Operations screen, click on Add…   

__ a. Select Generic FTP business object for the Data type and click Next  

 

You are now back to Operation window and because you have chosen the data type with no business 
graph, the Data type is populated as FTPFile  

__ b. For Operation name, enter emitFTPFile1  

__ c. Accept the default Data type, FTPFile  

__ d. For Data binding , select Use a data binding configuration  from the dropdown list 

__ e. Define Data Binding type configuration: 

1) Click Browse…  next to Data binding configuration . A Data Binding Selection window is 
opened. 

2) Select FTPPSDB under Matching data bindings list and click OK 
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__ f. Now the FTPPSDB is displayed for Data binding configuration in the Add Operation window: 

 

__ g. Click Finish . The above defined operations, emitFTPFile1 , is populated under Operations list 

 

Add emitFTPFile2 Operation 

____ 18. Repeat steps of Add emitFTPFile1  to add one more operation, emitFTPFile2, with these changes: 

__ a. Operation Name: emitFTPFile2  

 

____ 19. Click Finish . The above defined operations, emitFTPFile2 , is populated under Operations list 

 

____ 20. Click Next from Operations screen 
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____ 21. From Generate Artifacts screen: 

__ a. For Name, enter FTPPSInboundInterface  

 

__ b. Click Finish  

____ 22. The Assembly diagram for FTPPSInboundModule is opened with an Export component, 
FTPPSInboundInterface: 

 

__ a. Save (Ctrl + S ) changes to your assembly diagram 

Note : Because of the known limitation in the current driver, you need to manually change the Native 
method names. 

The table below summarizes the rules, operations you have defined so far in this lab. Note the last column, 
which shows the Native method name for each of the rule and operation defined: 

Object Name  Rule Operation Name Native method name = emit + Object Name 

FTPBG .*txt emitFTPFileBG emitFTPBG 

FTPType1 .*txt1 emitFTPFile1 emitFTPType1 

FTPType2 .*txt2 emitFTPFile2 emitFTPType2 

____ 23. Change the Native method binding name 

__ a. Ensure that the FTPPSInboundInterface is selected from the Assembly diagram 

__ b. From the bottom panel, select Properties > Binding > Method bindings  

__ c. From the Bound Methods list, click on emitFTPFileBG  
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__ d. From the right side, ensure that the Generic tab is selected, and then change the Native method  
to emitFTPBG  

 

__ e. From the Bound Methods list, click on emitFTPFile1  

__ f. Similarly, for emitFTPFile1 , change the Native method  to emitFTPType1  

 

__ g. Similarly, for emitFTPFile2 , change the Native method  to emitFTPType2  

 

__ h. Save (Ctrl + S ) your changes 
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____ 24. Review the FTPPSInboundModule: The generated Data Types , Interface , and Function selector 
(GenericFS ) and Data binding (FTPPSDB) under Configured Resources can be found inside 
FTPPSInboundModule  

 

You can open each of these generated artifacts and business objects and review the properties inside.  

Review the created methods inside the interface: 

__ a. From the Business Integration view, expand FTPPSInboundModule > Interfaces and then 
double-click on FTPPSInboundInterface  to open it 

__ b. You should see these three operations: 

 

__ c. Close the interface, FTPPSInboundInterface 
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2.2. Add Java component 

In this part of the lab, you will add a Java component and then wire the component to the existing Export 
interface. The Java component is your endpoint. 

____ 1. Open the assembly diagram for FTPPSInboundModule (if it is already not open) 

__ a. From the business integration view, expand FTPPSInboundModule  and double click on 
Assembly diagram 

____ 2. Drop a Java component to onto the assembly diagram 

__ a. From the Palette , click on Components  to expand it 

 

__ b. Click on Java  and then click on the empty space of FTPPSInboundModule assembly diagram. 
This will place a new component, Component1  on the assembly diagram.   

____ 3. Wire the FTPPSInboundInterface to the Component1 

__ a. Select the wire  ( ) icon from the Palette 

__ b. Click on FTPPSInboundInterface  and then click on Component1  to wire them together 

__ c. Select OK for the Add Wire pop-up window: 

 

__ d. From the top of the Palette, click on the Selection Tool  icon ( ) to get back to the normal 
cursor mode 

__ e. Right-click on the empty space of the Assembly diagram and select Arrange Contents 
Automatically  from the pop-up menu 
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Your assembly diagram for FTPPSInboundModule will look like this: 

 

__ f. Right-click on Component1  and select Generate Implementation from the pop-up menu 

__ g. On the Generate Implementation panel, select default package , and click OK 

__ h. Component1Impl.java  is opened in Assembly editor. Scroll down to the method 
emitFTPFileBG (DataObject emitFTPFileBGInput)  that needs to be implemented and add this 
code under that method:  

public void emitFTPFileBG(DataObject emitFTPFileBGInput) { 
  //TODO Needs to be implemented. 

System.out.println("***********Inside emitFTPFileBG: type .txt 
files************"); 

__ i. Similarly add the print statement to emitFTPFile1  method: 

     public void emitFTPFile1(DataObject emitFTPFile1Input) { 
  //TODO Needs to be implemented. 

 System.out.println("***********Inside emitFTPFile1:type .txt1 
files************"); 

__ j. And finally, add the print statement to emitFTPFile2  method: 

public void emitFTPFile2(DataObject emitFTPFile2Input) { 
  //TODO Needs to be implemented. 

 System.out.println("***********Inside emitFTPFile2:type .txt2 
files************"); 

__ k. Save (Ctrl + S ) and close Component1Impl.java 

__ l. Save (Ctrl + S ) and close Assembly diagram: FTPPSInboundModule 
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2.3. Test pass through scenario 

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA 
application Inbound processing for the Pass through scenario. 

____ 1. Add the project to the WebSphere Test Environment server 

__ a. Right-click on WebSphere Process Server v6.1  under the Servers view and select Add and 
remove projects…  from the pop-up menu 

__ b. From the Add and Remove Projects window, select FTPPSInboundModuleApp  under Available 
projects panel and click Add >  

__ c. You will now see the FTPPSInboundModuleApp  added to the Configured projects  

__ d. Click Finish  and wait until the project is being published onto the server. The server is started in 
Debug mode if it is not already started before 

____ 2. Test the application by providing three different input files: 

Note : For your convenience, three test files, sample.txt, sample.txt1, sample.txt2  are placed in 
<FTPFILES>.  

Test scenario 1:  .txt files  

__ a. On the machine where the FTP Server is running, put sample.txt  file in the EventDir . The 
adapter will poll the copied file from the event directory and will transfer it to the archive directory 

__ b. Because you have placed a .txt  file, it will pass through the emitFTPFileBG  method and you 
should see this message in the console (or SystemOut.log): 

SystemOut     O ***********Inside emitFTPFileBG:type .txt files************ 

Verify the results:  

__ c. Check the <LOCAL_EVENT_DIR>  on your local machine. The file is quickly moved from this 
directory to the local archive directory 

__ d. Check the ArchiveDir  of your FTP server which should contain the same file name appended 
with year, month, date, system time, and processed as you have given 

__ e. Check the <LOCAL_ARCHIVE_DIR>  subdirectory which should contain an archive of the event 
file, with the same file name appended with year, month, date, system time, and success 

Test scenario 2: .txt1 files : 

__ f. On the machine where the FTP Server is running, put sample.txt1  file in the EventDir . The 
adapter will poll the copied file from the event directory and will transfer it to the archive directory 

__ g. Because you have placed a .txt1  file, it will pass through the emitFTPFile1  method and you 
should see this message in the console (or SystemOut.log): 

SystemOut     O ***********Inside emitFTPFile1:type .txt1 files************ 

Verify the results:  
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__ h. Check the <LOCAL_EVENT_DIR>  on your local machine. The file is quickly moved from this 
directory to the local archive directory 

__ i. Check the ArchiveDir  of your FTP server which should contain the same file name appended 
with year, month, date, system time, and processed as you have given 

__ j. Check the <LOCAL_ARCHIVE_DIR>  subdirectory which should contain an archive of the event 
file, with the same file name appended with year, month, date, system time, and success 

Test scenario: .txt2 files : 

__ k. On the machine where the FTP Server is running, put sample.txt2  file in the EventDir . The 
adapter will poll the copied file from the event directory and will transfer it to the archive directory 

__ l. Because you have placed a .txt2  file, it will pass through the emitFTPType2  method and you 
should see this message in the console (or SystemOut.log): 

SystemOut     O ***********Inside emitFTPFile2:type .txt2 files************ 

Verify the results:  

__ m. Check the <LOCAL_EVENT_DIR>  on your local machine. The file is quickly moved from this 
directory to the local archive directory 

__ n. Check the ArchiveDir  of your FTP server which should contain the same file name appended 
with year, month, date, system time, and processed as you have given: 

 

__ o. Check the <LOCAL_ARCHIVE_DIR>  subdirectory which should contain an archive of the event 
file, with the same file name appended with year, month, date, system time, and success 

 

____ 3. Restore the Sever Configuration 

__ a. Right-click on WebSphere Process Server v6.1  under the Servers view and select Add and 
remove projects…  from the pop-up menu 

__ b. Select FTPPSInboundModuleApp  under Configured projects and click < Remove  

__ c. Click Finish  after you see the application moved to Available projects. Wait until the application 
is being unpublished 
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2.4. Test pass through scenario with SplitBySize 

In this last part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA 
application Inbound processing for the pass through scenario with split by size. 

____ 4. Configure/change the adapter properties from the Properties view: 

__ a. Change to Business Integration perspective if you are in a different perspective 

1) Select Window > Open Perspective > Other…  

2) From the Select Perspective window, select Business Integration (default)  and click OK 

__ b. Expand FTPPSInboundModule  and double-click FTPPSInboundModule to open it in Assembly 
Editor 

__ c. Click on FTPPSInboundInterface  from the Assembly Editor and select Properties  tab from the 
bottom 

__ d. Select Binding  under Properties and select End-point configuration  under Binding itself and 
then select the Connection tab 

__ e. Now under ActivationSpec Properties , you can review the properties that were given during 
the external service wizard 
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__ f. Scroll down to Advanced Properties  

1) Specify criteria to split file content: 1000 

Note: The value, 1000, you entered for the field, Specify criteria to split the content, is the size of the input 
file in Bytes.  

2) Split function class name: com.ibm.j2ca.utils.filesplit.SplitBySize (default)  

 

__ g. Click on Assembly diagram (or any where else so that the save button is enabled) and then save 
(Ctrl +S)  your changes 
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____ 5. Modify Java code: 

__ a. From the assembly diagram of FTPPSInboundModule , double-click on Component1  

__ b. Component1Impl.java  is opened in Assembly editor. Scroll down to the method 
emitFTPFileBG (DataObject emitFTPFileBGInput)  that needs to be implemented and add this 
code under that method:  

public void emitFTPFileBG(DataObject emitFTPFileBGInput) { 
  //TODO Needs to be implemented. 

 System.out.println("***********Inside emitFTPFileBG: type .txt   
files************"); 

  DataObject FTPFile = emitFTPFileBGInput.getDataObject("FTPFile"); 
  DataObject Unstructured = FTPFile.getDataObject("Content"); 
  String astext = Unstructured.getString("AsText"); 

 System.out.println("File content-----> "+astext); 

Note: You can also copy the Java code from <FTPFILES>\SplitBySizeJavaCode.txt . 

__ c. Save (Ctrl + S ) and close Component1Impl.java 

__ d. Save (Ctrl + S ) and close Assembly diagram: FTPPSInboundModule 

____ 6. Repeat Step 1 of part 2.3 to add the saved project FTPPSInboundModuleApp  to the server 

____ 7. Test the application with and input file larger than 1000 Bytes  

Note : For your convenience, a test file SplitBySize.txt  is placed in <FTPFILES>. The size of the file is 
around 3KB.  

__ a. On the machine where the FTP Server is running, put SplitBySize.txt  file in the EventDir . The 
adapter will poll the copied file from the event directory and will transfer it to the archive directory 

__ b. Because you have placed a .txt  file, it will pass through the emitFTPFileBG  method and you 
should see this message in the console (or SystemOut.log): 
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Note : The same SplitBySize.txt file, if delivered without specifying Split criteria to 1000 (about 1KB), will 
reach the end point only once. Here, in this part, you saw the successful event delivery message for three 
times for the same file (with the file size being 3KB) because of the split criteria that has been given as 
1KB, which means it splits the file into three parts and delivers to the endpoint. 

__ c. Check the <LOCAL_EVENT_DIR>  on your local machine. The file is quickly moved from this 
directory to the local archive directory 

__ d. Check the ArchiveDir  of your FTP server which should contain the same file name appended 
with year, month, date, system time, and processed as you have given 

__ e. Check the <LOCAL_ARCHIVE_DIR>  subdirectory which should contain an archive of the event 
file, with the same file name appended with year, month, date, system time, and success: 

 

__ f. Restore the Sever Configuration: follow the instructions under Step 3  of Part 2.3  
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Part 3: Content specific (non-pass through) scenari o 

Of the two flows, you have just tested the pass through scenario that does not involve data transformation. 
In this part of the lab, you will configure the non-pass through scenario using the new External Service 
option from the WebSphere Integration Developer and then test the configuration with different cases.  

Content specific flow for the inbound scenario: 

 

• Event data is picked from the event file based on SplitCriteria (it contains the delimiter which actually 
separates the BO’s in an event file), then converted into a input stream and then set on 
FTPInputStreamRecord. 

• The data handler should be set with a valid value. 

• Based on the wrapper generation selection, the protocol specific information such as event file name, 
directory name (LocalEventDirectory) which needs to be sent to the endpoint is also set in the 
FTPInputStreamRecord. 

• The FTPInputStreamRecord is sent to the the Function Selector. The Function Selector will invoke that 
data binding and get back a content specific data object (Customer SDO). That is used to generate the 
function name and emit that. If content-specific data binding is not valid, the Data Transformation 
Framework will flag appropriate error. 

• Optionally while sending protocol specific information like directoryName and fileName, you need the 
wrapper data object to hold this.  
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• This content specific data object is set on the wrapper data object if wrapper is used. Protocol specific 
information is also set in the wrapper. The content specific data or wrapper is sent directly or wrapper 
is set in a BG and sent to the end point. 
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3.1. Configure content specific (non-pass through) scenario using 
external service wizard 

In this part of the lab you will use this new external service feature to create and configure the function 
selector, data handler , and data binding and other required artifacts to test the inbound pass through 
scenario 

____ 1. Create FTPCustomInboundModule 

__ a. From the Business Integration window, right-click and select New > Module  

__ b. From the New Module window, enter FTPCustomInboundModule  for the Module Name 

__ c. Ensure that the box next to Open module assembly diagram  is checked and then click Finish  

You will now see a new module, FTPCustomInboundModule, created from your Business Integration 
window 

____ 2. Import required business objects 

__ a. Expand FTPCustomInboundModule (if not already expanded), right-click on Data Types  and 
select Import…  from the pop-up menu 

__ b. From the Import window, expand General  and select File System  and then click Next  

__ c. Enter From directory 

1) Click on Browse…  next to From directory   

2) From the Import from directory window, select <FTPFILES> and click OK 

Now, you will see FTPFiles folder added on the left side, and all the xsds and other files under that 
folder on the right side. 

__ d. Select the box next to Customer.xsd and Order.xsd  

__ e. Ensure that the FTPCustomInboundModule  is selected for Into folder 

__ f. Click Finish  from the Import window 

The Business Integration window is updated with the imported business objects.  

____ 3. Review imported business objects: 

__ a. Expand FTPCustomInboundModule > Data Types  and you will now see two new data types 
Customer and Order  under it.  
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__ b. Double-click on Customer  review the fields inside the object: 

 

____ 4. Now, double-click on Order and review the fields inside the object: 

 

____ 5. After reviewing, close the Customer business object from the Assembly editor 

____ 6. To start External Service from the Palette: 

__ a. From the Palette  on the left side of Assembly Diagram, click on Inbound Adapters : 

____ 7. Under Inbound Adapters, click on the FTP and then click on the empty canvas of the assembly 
diagram. The New FTP Service wizard is opened 

____ 8. From the FTP Service screen, select Create a service (advanced)  

 

__ a. Click Next  

Note: You can also start the External Service from the File menu  option: 
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From the main menu, select File > New > External Service . This opens an External Service wizard that 
helps you obtain a service which establishes connectivity with other systems. The wizard provides three 
connectivity options – Adapters, Registers, and Messaging  

Select the radio button next to Adapters  and click Next    

____ 9. On the Select an Adapter screen, expand IBM WebSphere Adapter for FTP (IBM : 6.1.0.0_IF03)  
and select CWYFT_FTPFile  

 

__ a. Click Next  

Note : If you are using the File menu  option to start the External Service wizard, you are asked to select 
the Processing Direction  at this point. Select the radio button next to Inbound  and click Next  to proceed 
to the next step. 

____ 10. Service Configuration Properties: 

__ a. Deploy connector project: ensure that the default option With module for use by single 
application  is selected 

__ b. Enter these for FTP system connection information: 

1) Host name: <FTP_Machine_Name>  (or IP Address of the machine that has FTP Server), 
for Ex: wsbeta181.austin.ibm.com 

2) Remote directory: full path of the EventDir created in on the machine  where FTP 
server is existing  (for Ex: /home/wsbeta/EventDir) 

Note : This is the directory from where adapter gets the event files 

3) Local directory: <LOCAL_EVENT_DIR>  

4) Port number: 21 (default) 

5) Protocol: FTP (default) 
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__ c. Click on Advanced >>  to see the hidden advanced properties that can be configured: 

 

You can click on each of the configuration and review the options available under it. For this lab, you will 
need only some of these properties. 

__ d. Event persistence configuration: 

1) Ensure that the Auto create event table  is checked  

2) Event recovery table name: FTPCustomTable  

3) Event recovery data source (JNDI) name: jdbc/FTP  
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Note : This represents the JNDI name of the Data Source used by Event Persistence to get the JDBC 
database connection. The Data Source must be created in the WebSphere Process Server. You should 
enter the data source JNDI name that you created in Step 3 of Part 1. 

 

Note : The Event recovery data source (JNDI) name is not mandatory  in V6.1. Now, the adapter can use 
in-memory representation  of event table to store all the necessary information. Adapter uses this feature 
when event database information is not configured during inbound event polling. This feature will not 
support the capability of handling “Ensure once-only event delivery”. 

__ e. Advanced connection properties: 

1) User name: username using which you connect to your FTP server  (for Ex: wsbeta) 

2) Password: password for the above user to connect to your FTP server  

__ f.  

__ g. FTP archiving configuration: 

1) Local Archive directory: click on Browse…  and select <LOCAL_ARCHIVE_DIR>  

2) Remote archive directory: full path of the ArchiveDir created in on the machi ne where 
FTP server is existing  (for Ex: /home/wsbeta/ArchiveDir) 
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____ 11. For this lab, you are not going to use the J2C authentication. So, uncheck  the box next to Specify 
a Java Authentication and Authorization Services (J AAS) alias security credentials . 

 

Function Selector Configuration : Of the two function selectors that are supported by the FTP adapter, 
FilenameFunctionSelector was used for pass through scenario. The EmbeddedNameFunctionSelector 
is used in case of content-specific business objects, where the object name is embedded in the event file. 
The EmbeddedNameFunctionSelector will return the function name based on the content data. For 
example, if the content-specific business object is CustomerWrapperBG, the function returned by the 
function selector is emitCustomer. This function selector should be configured with a data handler. The 
data binding should be the adapter-specific WrapperDataBinding. The data binding should be configured 
to use the same data handler configured with the function selector. 

____ 12. Under Service properties, for Function selector, select Use a function selector configuration  from 
the drop down menu 

Note : If you select Use default function selector ‘FilenameFunctionSele ctor’  option for the Function 
selector, the adapter automatically creates a function selector with FilenameFunctionSelector as the class 
name. For non-pass through scenario, you need to define a function selector that uses 
EmbeddedNameFunctionSelector . 

____ 13. Click on New to create a new Function selector. The Resource Configuration window is opened. 

__ a. Ensure that the selected module is FTPCustomInboundModule  

__ b. For Name, enter any string. For Ex: CustomFS  

 

1) Click Next  
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__ c. In the next ‘Select a configuration type’ screen: 

1)  Click on Browse…  next to Class Name. Function Selector Selection window is opened. 

2) From the Function Selectors list, select EmbeddedNameFunctionSelector properties  

 

3) Click OK  
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4) You are now back to the Resource Configuration window and the above selected Function 
Selector, com.ibm.j2ca.extension.emd.runtime.EmbeddedNameFunc tionSelector , is 
displayed as the Class Name of the function selector:  

 

__ d. Click Next  

The next screen is ‘Specify Properties’ screen where you define the data handler and encoding used 
in inbound processing. 

Data handler configuration : 

__ e. Click on New… next to Data handler configuration name. A new Resource Configuration window 
is opened for you to define the data handler 
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__ f. Ensure that the module selected is FTPCustomInboundModule and enter CustomDH  for the 
Name of the data handler that is created. 

 

__ g. Click Next  

__ h. From the Select a Configuration type screen, select the radio button next to Data Handler  

__ i. Click on Browse…  next to Class Name. Data Handler Selection window is opened. 

__ j. Select XML Data Handler  from the Data Handlers list 

 

__ k. Click OK 
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__ l. You are now back to Resource Configuration window and the above selected data handler, 
com.ibm.wbiserver.datahandler.xml.XMLDataHandler , is displayed as the Class Name of 
Data Handler: 

 

__ m. Click Next  

__ n. Accept the default encoding ‘UTF-8’ and click Finish  

__ o. From the next screen: 

1) The Data handler configuration name, CustomDH  is displayed which was defined in the 
previous steps 

2) Encoding: click on Select...  and then select UTF-8 from the Select window and click OK 
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__ p. Click Finish  

You are now done with configuring the Function Selector, CustomFS and, in that process, configured a 
data handler, CustomDH inside the function selector configuration wizard. You are back to the 
External Service wizard and the above configured function selector, CustomFS is displayed for 
Function Selector Configuration field: 

 

Data binding configuration : 

____ 14. You can define data binding in two places - service level (current screen of External Service wizard) 
or later at the method level (Operations screen of the External Service wizard). In this lab, you will 
define data binding at the service level (from this screen) 

__ a. From the dropdown menu next to Data binding, select ‘Use a data binding configuration for all 
operations ’ 

 

____ 15. Click New… next to Data binding configuration . A Binding Resource Configuration window is 
opened 

__ a. Ensure that the selected module is FTPCustomInboundModule  

1) For the Name, enter CustomDB  

 

2) Click Next  
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__ b. Accept the default data binding Class Name, 
com.ibm.j2ca.ftp.emd.runtime.FTPFileBaseDataBinding  

 

__ c. Click Next  

__ d. For Data Handler, you can use the one already configured while configuring the Function 
Selector in the previous steps. 

1) For Binding type, make sure that DataHandler  is selected from the drop down menu 

2) Click on Browse…  next to Configured data handler. A Data Handler Selection window is 
opened 

3) Select CustomDH  from Data Handlers list: 

 

4) Click OK 
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__ e. The selected Data Handler is displayed for Configured data handler field: 

 

__ f. Click Finish  

__ g. Now the CustomDB  is displayed for Data binding configuration  

 

__ h. Click Next  

____ 16. Check the box next to Change logging properties for wizard  to view the output location of the log 
file and the logging level and click Next  

Define emitCustomerFile operation : 

____ 17. From the Operations screen, click on Add…   

Add Operation window is opened 

__ a. Select User defined type  for the Data type and click Next  

 

You are now back to Operation window and because you chose the User defined data type, the Data 
type is blank 

__ b. For Operation name, enter emitCustomerFile  
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__ c. Define Input type: 

1) Click New… next to Input type  to open a New Business Object window 

2) From this window, ensure that the Module selected is FTPCustomInboundModule  and 
click Next  

3) Click on Browse…  next to Data type  

4) From the Data Type Selection window, select Customer  under Matching data types: 

 

5) Click OK 

6) From the Type Wizard, check  the box next to Generate business graph for each 
business object  

 

7) Click Finish  

__ d. The Input Type in Add Operation window is populated with CustomerWrapperBG, because you 
have selected to have business graph (BG) generated 
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__ e. For Data binding , select Use data binding configuration ‘CustomDB’ from the drop down list 

 

__ f. Click Finish  

__ g. The above defined operation: emitCustomerFile is populated in the Operations list. 

 

Define emitOrderFile operation : 

____ 18. From the Operations screen, click on Add…   

Add Operation window is opened 

__ a. Select User defined type  for the Data type and click Next  

You are now back to Operation window and because you chose the User defined data type, the Data 
type is blank. 

__ b. For Operation name, enter emitOrderFile  

__ c. Define Input type: 

1) Click New… next to Data type  to open a Type Wizard window 

2) From the next screen, ensure that FTPCustomInboundModule  is selected and click Next  

3) Click on Browse…  next to Data type  
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4) From the Data Type Selection window, select Order  under Matching data types: 

 

5) Click OK 

6) Do not  check the box next to Generate business graph for each business object  

Note: In V6.1, the generation of business graph is optional and you can leave this option unchecked. As a 
result, Adapter will not generate the BG for Order business object and you can confirm this bye reviewing 
the generated data types from the business integration view of your WebSphere Integration Developer. 

 

7) Click Finish  

__ d. The Input Type in Add Operation window is populated with OrderWrapper , because you have 
not  selected to have business graph (BG) generated 
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__ e. For Data binding , select Use data binding configuration ‘CustomDB’ from the drop down list 

 

__ f. Click Finish  

__ g. The above defined operation; emitOrderFile is populated in the Operations list 

 

__ h. Click Next  

____ 19. From the Generate Artifacts screen, enter these: 

__ a. For Name, enter FTPCustomInboundInterface  

 

__ b. Click Finish  

____ 20. You will now see a new export component, FTPCustomInboundInterface  in the assembly diagram 
of FTPCustomInboundModule 

 

__ a. Save (Ctrl+S)  your changes to the assembly diagram 
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____ 21. Review the generated Native method bindings for the defined operations: 

__ a. Ensure that the FTPCustomInboundInterface is selected from the Assembly diagram 

__ b. From the bottom panel, select Properties > Binding > Method bindings  

Note : The Native method name should be ‘emit’ added as a prefix to the business object name, that is., 
Native method = emit + Business Object name . In this case, for the processed business object 
Customer, the Native method is emitCustomer  and for Order , it is emitOrder . 

__ c. From the Bound Methods list, click on emitCustomerFile and you should see emitCustomer  as 
the Native method  

__ d. Now, click on emitOrderFile  from Bound Methods and you should see emitOrder as the Native 
method  

____ 22. Review the FTPCustomInboundModule: The generated Data Types , Interface , and the Function 
selector (CustomFS ) Data binding (CustomDB ), and Data handler (CustomDH ) under Configured 
Resources can be found inside FTPCustomInboundModule  

 

You can open each of these generated artifacts and business objects and review the properties inside.  

Review the created methods inside the interface: 

__ a. From the Business Integration view, expand FTPCustomInboundModule > Interfaces and then 
double-click on FTPCustomInboundInterface  to open it 
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__ b. You should see these two operations: 

 

__ c. Close the interface, FTPCustomInboundInterface 
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3.2. Add Java component 

In this part of the lab, you will add a Java component to the module and then wire the export to the added 
component. Then you will add the custom Java code to the added module. 

____ 1. Open the assembly diagram for FTPCustomInboundModule, if it is already not open 

__ a. From the business integration view, expand FTPCustomInboundModule  and double click on 
Assembly diagram 

____ 2. Drop a Java component to onto the assembly diagram 

__ a. From the Palette, click on Components to expand it 

 

__ b. Click on Java  and then click on the empty space of FTPCustomInboundModule assembly 
diagram. This will place a new component, Component1 on the assembly diagram.   

____ 3. Wire the FTPCustomInboundInterface to the Component1 

__ a. Select the wire  ( ) icon from the Palette 

__ b. Click on FTPCustomInboundInterface  and then click on Component1  to wire them together 

__ c. Select OK for the Add Wire pop-up window: 

Your assembly diagram for FTPCustomInboundModule will look like this: 

 

__ d. From the top of the Palette, click on the Selection Tool  icon ( ) to get back to the normal 
cursor mode 

____ 4. Generate Java Implementation 

__ a. Right-click on Component1  and select Generate Implementation from the pop-up menu 

__ b. On the Generate Implementation panel, select default package, and click OK 
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__ c. Component1Impl.java  is opened in Assembly editor. Scroll down to the method 
emitCustomerFile(DataObject emitCustomerFileInput)   that needs to be implemented and 
add this code under that method: 

System.out.println("*************ENDPOINT emitCustomer**************"); 
DataObject wrapper = 
emitCustomerFileInput.getDataObject("CustomerWrapper"); 
String filename = wrapper.getString("fileName"); 
System.out.println("FILENAME : "+filename); 
DataObject customer = wrapper.getDataObject("Content"); 
String name = customer.getString("customerName"); 
System.out.println("NAME-----> "+name); 
String address = customer.getString("Address"); 
System.out.println("ADDRESS--> "+address); 
String city = customer.getString("City"); 
System.out.println("CITY-----> "+city); 
String state = customer.getString("State"); 

System.out.println("STATE----> "+state); 

Note : The code is also available at <FTPFILES>\CustomerJavaCode.txt  for your convenience  

__ d. Scroll down to the method emitOrderFile(DataObject emitOrderFileInput)  and add this code: 

System.out.println("*************ENDPOINT emitOrder**************"); 
System.out.println("FILENAME : 
"+emitOrderFileInput.getString("FileName")); 
 
DataObject order = emitOrderFileInput.getDataObject("Content"); 
String OrderNumber = order.getString("OrderNumber"); 
System.out.println("ORDER NUMBER-----> "+OrderNumber); 
String OrderType = order.getString("OrderType"); 
System.out.println("ORDER TYPE--> "+OrderType); 
String Quantity = order.getString("Quantity"); 
System.out.println("QUANTITY-----> "+Quantity); 
String Price = order.getString("Price"); 

    System.out.println("PRICE----> "+Price); 

Note : The code is also available at <FTPFILES>\OrderJavaCode.txt  for your convenience  

__ e. Save (Ctrl + S ) and close Component1Impl.java 

____ 5. Save (Ctrl + S ) and close Assembly diagram: FTPCustomInboundModule 
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3.3. Test non pass through scenario 

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA 
application Inbound processing for the non pass through Scenario with input file having a single business 
object. 

____ 1. Add the project to the WebSphere Test Environment server 

__ a. Right-click on WebSphere Process Server v6.1  under the Servers view and select Add and 
remove projects…  from the pop-up menu 

__ b. From the Add and Remove Projects window, select FTPCustomInboundModuleApp  under 
Available projects panel and click Add >  

__ c. You will now see the FTPCustomInboundModuleApp  added to the Configured projects  

__ d. Click Finish  and wait until the project is being published onto the server. The server is started in 
Debug mode if it is not already started before 

____ 2. Put the input files in the event directory 

Note : For your convenience, the test files SingleCustomerBO.xml, SingleOrderBO.xml  are placed in 
<FTPFILES>. 

__ a. On the machine where the FTP Server is running, put SingleCustomerBO.xml  file in the 
EventDir . The adapter will poll the copied file from the event directory and will transfer it to the 
archive directory 

__ b. Because you have placed a file that contains a BO of type Customer, it will pass through the 
emitCustomerFile  method and you should see this message in the console (or SystemOut.log): 

 

__ c. On the machine where the FTP Server is running, put SingleOrderBO.xml  file in the EventDir . 
The adapter will poll the copied file from the event directory and will transfer it to the archive 
directory 

__ d. Because you have placed a file that contains a BO of type Order, it will pass through the 
emitOrderFile  method and you should see this message in the console (or SystemOut.log): 

 

____ 3. You can also verify the results by reviewing the archive directory 
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__ a. Check the ArchiveDir  of your FTP server which should contain the same file name appended 
with year, month, date, system time, and processed 

__ b. Check the <LOCAL_ARCHIVE_DIR>  subdirectory which should contain two archives of the 
event files, with the same file name appended with year, month, date, system time, and success 

 

____ 4. Restore the Sever Configuration 

__ a. Right-click on WebSphere Process Server v6.1  under the Servers view and select Add and 
remove projects…  from the pop-up menu 

__ b. Select FTPCustomInboundModuleApp  under Configured projects and click < Remove  

__ c. Click Finish  after you see the application moved to Available projects. Wait until the application 
is being unpublished 
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3.4. Test non pass through scenario with SplitByDel imiter 

In this last part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA 
application Inbound processing for the non pass through Scenario with input file having multiple business 
objects separated by a delimiter. 

____ 1. Configure/change the adapter properties from the Properties view: 

__ a. Change to Business Integration perspective if you are in a different perspective 

1) Select Window > Open Perspective > Other…  

2) From the Select Perspective window, select Business Integration (default)  and click OK 

__ b. Expand FTPCustomInboundModule  and double-click FTPCustomInboundModule to open it 
in Assembly Editor 

__ c. Click on FTPCustomInboundInterface  from the Assembly Editor and select Properties  tab 
from the bottom 

__ d. Select Binding  under Properties and select End-point configuration  under Binding itself and 
then select the Connection  

__ e. Now click on Advanced>> button at the bottom 

__ f. You can see all the properties that were given during the external service wizard 

__ g. Scroll down to File system connection information part and enter these: 

1) Specify criteria to split file content: ##### 

2) Split function class name: com.ibm.j2ca.utils.filesplit.SplitByDelimiter  

__ h. Click on Assembly diagram (or any where else so that the save button is enabled) and then save 
(Ctrl +S) your changes 

____ 2. Repeat Step 1 of part 3.3 to add the saved project FTPCustomInboundModuleApp to the server 

____ 3. Test the input file CustomerSplitByDelimiter.xml 

Note : For your convenience, a test file CustomerSplitByDelimiter.xml  is placed in <FTPFILES>. The file 
contains two Customer Business Objects separated by the delimiter #####.  

__ a. On the machine where the FTP Server is running, put CustomerSplitByDelimiter.xml  file in the 
EventDir . The adapter will poll the copied file from the event directory and will transfer it to the 
archive directory 

__ b. Because you have placed a file that contains BOs of type Customer, it will pass through the 
emitCustomerFile  method and you should see this message in the console (or SystemOut.log): 
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Note : You will see the successful event delivery message twice as there were two Business Objects 
present in the event file separated by the delimiter #####. 

 

 

1) Check your <ARCHIVE_DIR> which should contain an archive of the event file, with the 
same file name appended with year, month, date, system time, and success 

 

____ 4. Test the input file: OrderSplitByDelimiter.xml  

Note : For your convenience, the test file OrderSplitByDelimiter.xml  is placed in <LAB_FILES>\FTPfiles . 
The file contains two Order Business Objects separated by the delimiter #####.  

__ a. On the machine where the FTP Server is running, put OrderSplitByDelimiter.xml  file in the 
EventDir . The adapter will poll the copied file from the event directory and will transfer it to the 
archive directory 

__ b. Because you have placed a file that contains BOs of type Order, it will pass through the 
emitOrderFile  method and you should see this message in the console (or SystemOut.log): 

Note : You will see the successful event delivery message twice as there were two Business Objects 
present in the event file separated by the delimiter #####. 
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1) Check your <ARCHIVE_DIR> which should contain an archive of the event file, with the 
same file name appended with year, month, date, system time, and success 

 

____ 5. Repeat Step 4 of part 3.3 to restore the sever configuration 
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Part 4: Use default function selector and data bind ing 

This part of the lab will show you how to use the default use the default function selector and data binding 
options from the External Service wizard and generate other required artifacts.  

When you use the default function selector, you cannot define the rules as you did in Part 2 and hence 
there will only be one method that handles all types of files.  

When you use the default data binding, you cannot have multiple data types as in Part 3 and each data 
type is handled by different method. Instead, there will only be one method and one data type. 

After running the External Service wizard, you will add the required Java component with implementation 
and then will continue to test the adapter. 
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4.1. Configure inbound using default function selec tor and data 
binding 

In this part of the lab you will use the default function selector and data binding options from the External 
Service wizard and generate other required artifacts to test the inbound scenario. 

____ 1. Create FTPDefaultsInboundModule 

__ a. From the Business Integration window, right-click and select New > Module  

__ b. From the New Module window, enter FTPDefaultsInboundModule  for the Module Name 

__ c. Ensure that the box next to Open module assembly diagram  is checked and then click Finish  

You will now see a new module, FTPDefaultsInboundModule, created from your Business Integration 
window 

____ 2. To start External Service from the Palette: 

__ a. From the Palette  on the left side of Assembly Diagram, click on Inbound Adapters : 

__ b. Under Inbound Adapters, click on the FTP and then click on the empty canvas of the assembly 
diagram. The New FTP Service wizard is opened 

____ 3. From the FTP Service screen, select Create a service (advanced)  

 

__ a. Click Next  

Note: You can also start the External Service from the File menu  option: 

From the main menu, select File > New > External Service . This opens an External Service wizard that 
helps you obtain a service which establishes connectivity with other systems. The wizard provides three 
connectivity options – Adapters, Registers, and Messaging  

Select the radio button next to Adapters  and click Next .  

____ 4. On the Select an Adapter screen, expand IBM WebSphere Adapter for FTP (IBM : 6.1.0.0_IF03)  
and select CWYFT_FTPFile  

__ a. Click Next  
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Note : If you are using the File menu  option to start the External Service wizard, you are asked to select 
the Processing Direction  at this point. Select the radio button next to Inbound  and click Next  to proceed 
to the next step. 

____ 5. Service Configuration Properties: 

__ a. Deploy connector project: ensure that the default option With module for use by single 
application  is selected 

__ b. Enter these for FTP system connection information: 

1) Host name: <FTP_Machine_Name>  (or IP Address of the machine that has FTP Server), 
for Ex: wsbeta181.austin.ibm.com 

2) Remote directory: full path of the EventDir created in on the machine  where FTP 
server is existing  (for Ex: /home/wsbeta/EventDir) 

Note : This is the directory from where adapter gets the event files 

3) Local directory: <LOCAL_EVENT_DIR>  

4) Port number: 21 (default) 

5) Protocol: FTP (default) 

 

__ c. Click on Advanced >>  to see the hidden advanced properties that can be configured: 

You can click on each of the configuration and review the options available under it. For this part of the lab, 
you will need only some of these properties. 

__ d. Event persistence configuration: In this part of the lab, you will not use any JNDI instead use 
adapter’s in-memory representation of event table to store all the necessary information 

Note : The Event recovery data source (JNDI) name is not mandatory  in V6.1. Now, the adapter can use 
in-memory representation  of event table to store all the necessary information. Adapter uses this feature 
when event database information is not configured during inbound event polling. This feature will not 
support the capability of handling “Ensure once-only event delivery”. 

__ e. Advanced connection properties:  
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1) User name: username using which you connect to your FTP server  (for Ex: wsbeta) 

2) Password: password for the above user to connect to your FTP server  

 

__ f. FTP archiving configuration: 

1) Local Archive directory: click on Browse…  and select <LOCAL_ARCHIVE_DIR>  

2) Remote archive directory: full path of the ArchiveDir created in on the machi ne where 
FTP server is existing  (for Ex: /home/wsbeta/ArchiveDir) 

 

____ 6. For this lab, you are not going to use the J2C authentication. So, uncheck  the box next to Specify 
a Java Authentication and Authorization Services (J AAS) alias security credentials . 

____ 7. Under Service properties, for Function selector , select Use default function selector 
‘FilenameFunctionSelector’  from the drop down list 

____ 8. For Data binding , select Use default data binding ‘FTPFileBaseDataBinding’ f or all operations  
from the drop down list 

 

____ 9. Check the box next to Change logging properties for wizard  to view the output location of the log 
file and the logging level and click Next  

Define emitFTPFileBG operation : 
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____ 10. From the Operations screen, click on Add…   

__ a. Add Operation window is opened. Select Generic FTP business object with business graph 
for the Data type and click Next  

 

You are back to Operation window and because you have chosen the data type with business graph, 
the Input type is populated as FTPFileBG . 

____ 11. For Operation name , enter any name, for Ex: emitFTPFileBG  

____ 12. Accept the default selection, Use suggested data binding ‘FTPFileBaseDataBinding’ , for Data 
binding  

 

__ a. Click Finish . The above defined operation, emitFTPFileBG , is populated under Operations list 

 

__ b. Click Next from Operations screen 

____ 13. From Generate Service screen, accept the default value, FTPExport , for Name 

 

__ a. Click Finish  
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____ 14. The Assembly diagram for FTPDefaultsInboundModule is opened with an Export component, 
FTPExport : 

 

____ 15. Save (Ctrl + S ) changes to your assembly diagram 
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4.2. Add Java component 

In this part of the lab, you will add a Java component and then wire the component to the existing Export 
interface. The Java component is your endpoint. 

____ 1. Open the assembly diagram for FTPDefaultsInboundModule (if it is already not open) 

__ a. From the business integration view, expand FTPDefaultsInboundModule  and double click on 
Assembly diagram 

____ 2. Drop a Java component to onto the assembly diagram 

__ a. From the Palette , click on Components  to expand it 

__ b. Click on Java  and then click on the empty space of FTPDefaultsInboundModule assembly 
diagram. This will place a new component, Component1  on the assembly diagram.   

____ 3. Wire the FTPExport to the Component1 

__ a. Select the wire  ( ) icon from the Palette 

__ b. Click on FTPExport  and then click on Component1  to wire them together 

__ c. Select OK for the Add Wire pop-up window: 

__ d. From the top of the Palette, click on the Selection Tool  icon ( ) to get back to the normal 
cursor mode 

__ e. Right-click on the empty space of the Assembly diagram and select Arrange Contents 
Automatically  from the pop-up menu 

Your assembly diagram for FTPDefaultsInboundModule will look like this: 

 

__ f. Right-click on Component1  and select Generate Implementation from the pop-up menu 

__ g. On the Generate Implementation panel, select default package , and click OK 

__ h. Component1Impl.java  is opened in Assembly editor. Scroll down to the method 
emitFTPFileBG (DataObject emitFTPFileBGInput)  that needs to be implemented and add this 
code under that method:  

public void emitFTPFileBG(DataObject emitFTPFileBGInput) { 
  //TODO Needs to be implemented. 

System.out.println("***********Reached Endpoint************"); 

__ i. Save (Ctrl + S ) and close Component1Impl.java 
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__ j. Save (Ctrl + S ) and close Assembly diagram: FTPDefaultsInboundModule 
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4.3. Test defaults scenario 

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA 
application Inbound processing for the pass through scenario. 

____ 1. Add the project to the WebSphere Test Environment server 

__ a. Right-click on WebSphere Process Server v6.1  under the Servers view and select Add and 
remove projects…  from the pop-up menu 

__ b. From the Add and Remove Projects window, select FTPDefaultsInboundModuleApp  under 
Available projects panel and click Add >  

__ c. You will now see the FTPDefaultsInboundModuleApp  added to the Configured projects  

__ d. Click Finish  and wait until the project is being published onto the server. The server is started in 
Debug mode if it is not already started before 

____ 2. Test the application by providing three different input files: 

Note : For your convenience, three test files, sample.txt, sample.txt1, sample.txt2  are placed in 
<FTPFILES>.  

__ a. On the machine where the FTP Server is running, put sample.txt (or any of the three sample 
files) file in the EventDir . The adapter will poll the copied file from the event directory and will 
transfer it to the archive directory 

__ b. No matter what type of file you put in Event directory, it will pass through the only existing 
method, emitFTPFileBG , and you should see this message in the console (or SystemOut.log): 

SystemOut     O ***********Reached Endpoint************ 

Verify the results:  

__ c. Check the <LOCAL_EVENT_DIR>  on your local machine. The file is quickly moved from this 
directory to the local archive directory 

__ d. Check the ArchiveDir  of your FTP server which should contain the same file name appended 
with year, month, date, system time, and processed as you have given 

__ e. Check the <LOCAL_ARCHIVE_DIR>  subdirectory which should contain an archive of the event 
file, with the same file name appended with year, month, date, system time, and success 

____ 3. Restore the Sever Configuration 

__ a. Right-click on WebSphere Process Server v6.1  under the Servers view and select Add and 
remove projects…  from the pop-up menu 

__ b. Select FTPDefaultsInboundModuleApp  under Configured projects and click < Remove  

__ c. Click Finish  after you see the application moved to Available projects. Wait until the application 
is being unpublished 
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Part 5: Use ‘Create a service from a typical patter n’ 

In this part of the lab you will use the typical pattern  option from the External Service wizard to create and 
configure the Function Selector, Data Binding and other required artifacts to test the inbound scenario. 

Based on your selection, the Binding resources (data binding and function selector) are created which you 
will review later in this part.  

After running the External Service wizard, you will continue to add the Java component with 
implementation and then test the adapter. 
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5.1. Configure inbound using ‘Create a service from  a pattern 
(typical)’ option 

In this part of the lab you will use the typical pattern  from the External Service feature to create and 
configure the Function Selector 

____ 1. Create the module: FTPTypicalInboundModule 

__ a. From the Business Integration window, right-click and select New > Module  

__ b. From the New Module window, enter FTPTypicalInboundModule  for the Module Name 

__ c. Ensure that the box next to Open module assembly diagram  is checked and then click Finish  

You will now see a new module, FTPTypicalInboundModule , created from your Business Integration 
window and the Assembly diagram for the same module is opened in the Assembly Editor. 

____ 2. Import required business objects 

__ a. Expand FTPTypicalInboundModule (if not already expanded), right-click on Data Types  and 
select Import…  from the pop-up menu 

__ b. From the Import window, expand General  and select File System  and then click Next  

__ c. Enter From directory 

1) Click on Browse…  next to From directory   

2) From the Import from directory window, select <FTPFILES > and click OK 

Now, you will see FTPFiles folder added on the left side, and all the xsds and files under that folder on 
the right side. 

__ d. Select the box next to Customer.xsd  

__ e. Ensure that the FTPTypicalInboundModule  is selected for Into folder 

__ f. Click Finish  from the Import window 

The Business Integration window is updated with the imported business objects.  

____ 3. Review imported business object: 

__ a. Expand FTPTypicalInboundModule > Data Types  and you will now see a new data type 
Customer and Order  under it.  
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__ b. Double-click on Customer  review the fields inside the object: 

 

__ c. After reviewing, close the Customer business object from the Assembly editor 

____ 4. To start External Service from the Palette: 

__ a. From the Palette  on the left side of Assembly Diagram, click on Inbound Adapters : 

____ 5. Under Inbound Adapters, click on the FTP and then click on the empty canvas of the assembly 
diagram. The New FTP Service wizard is opened 
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____ 6. From the FTP Service screen, accept the default selection of Create a service from a pattern 
(typical)  

 

__ a. Click Next  

____ 7. From the next FTP service name  screen, for Name, accept the default value ‘FTPExport ’ and click 
Next  

 

____ 8. From the Business object and location screen, enter these: 

__ a. Click on Browse…  next to Business object  and a Data Type Selection window is opened 
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__ b. Select Customer  under Matching data types and click OK 

 

__ c. For FTP server host name , enter <FTP_Machine_Name>  (or IP Address of the machine that 
has FTP Server), for Ex: wsbeta181.austin.ibm.com 

__ d. Click on Test connection , next to host name and you should get this pop-up window with 
success message: 

 

__ e. Click OK from the above Test Results window 

__ f. For Remote directory , enter full path of the OutDir created on the machine wher e FTP 
server is existing  (for Ex: /home/wsbeta/OutDir) 

__ g. For Local staging directory , click on Browse…  and select <LOCAL_EVENT_DIR>  
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Your Business object and location screen should look like this: 

 

__ h. Click Next  

____ 9. From ‘FTP server security credential’ screen, enter these: 

__ a. Select the radio button next to Using user name and password  

1) User name: username using which you connect to your FTP server  (for Ex: wsbeta) 

2) Password: password for the above user to connect to your FTP server  

 



© Copyright IBM Corporation 2008. All rights reserved 

IBM WEBSPHERE ADAPTER 6.1 – LAB EXERCISE 

2008 March, 27 IBM WebSphere Adapter 6.1 – Lab exercise Page 77 of 87 

 WBIV61_IEA_AdapterFTPInboundLab.doc 

__ b. Click Next  

____ 10. From the Input file format and file content split option  screen, enter these: 

__ a. For input file format, accept the default XML selection 

__ b. For file content split  option, accept the default selection, None  

 

__ c. Click Next  

____ 11. From the ‘Archive directory and wrapper business object’ screen, enter these: 

__ a. Click on Browse…  next to Local archive directory  and select <LOCAL_ARCHIVE_DIR>  
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__ b. Check the box next to Use a wrapper business object to contain additional  input file 
information . This will generate a Customer Wrapper under the Data Types of your Module 

 

__ c. Click Finish  

____ 12. Save (Ctrl + S ) changes to your assembly diagram 

____ 13. Review the FTPTypicalInboundModule and the generated artifacts: The generated Data Types , 
Interface , Data handler (XMLDataHandler ) and Data binding (FTPFileXMLDataBinding ) under 
Configured Resources can be found under FTPTypicalInboundModule. You can open each of these 
generated artifacts, business objects and review the properties inside.   
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5.2. Add Java component 

In this part of the lab, you will add a Java component and then wire the component to the existing Export 
interface. The Java component is your endpoint. 

____ 1. Open the assembly diagram for FTPTypicalInboundModule (if it is already not open) 

__ a. From the business integration view, expand FTPTypicalInboundModule  and double click on 
Assembly diagram 

____ 2. Drop a Java component to onto the assembly diagram 

__ a. From the Palette , click on Components  to expand it 

__ b. Click on Java  and then click on the empty space of FTPTypicalInboundModule assembly 
diagram. This will place a new component, Component1  on the assembly diagram.   

____ 3. Wire the FTPExport to the Component1 

__ a. Select the wire  ( ) icon from the Palette 

__ b. Click on FTPExport  and then click on Component1  to wire them together 

__ c. Select OK for the Add Wire pop-up window: 

__ d. From the top of the Palette, click on the Selection Tool  icon ( ) to get back to the normal 
cursor mode 

__ e. Right-click on the empty space of the Assembly diagram and select Arrange Contents 
Automatically  from the pop-up menu 

Your assembly diagram for FTPTypicalInboundModule will look like this: 

 

__ f. Right-click on Component1  and select Generate Implementation from the pop-up menu 

__ g. On the Generate Implementation panel, select default package , and click OK 
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__ h. Component1Impl.java  is opened in Assembly editor. Scroll down to the method 
emitCustomer (DataObject emitCustomerInput)  that needs to be implemented and add this 
code under that method:  

System.out.println("*************ENDPOINT               
emitCustomer**************"); 
System.out.println("FILENAME : 
"+emitCustomerInput.getString("Filename")); 

  DataObject customer = emitCustomerInput.getDataObject("Content"); 
  String name = customer.getString("CustomerName"); 
  System.out.println("NAME-----> "+name); 
  String address = customer.getString("Address"); 
  System.out.println("ADDRESS--> "+address); 
  String city = customer.getString("City"); 
  System.out.println("CITY-----> "+city); 
  String state = customer.getString("State"); 
  System.out.println("STATE----> "+state); 

Note : The code is also available at <FTPFILES>\TypicalCustomerJavaCode.txt for your convenience  

__ i. Save (Ctrl + S ) and close Component1Impl.java 

__ j. Save (Ctrl + S ) and close Assembly diagram: FTPTypicalInboundModule 
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5.3. Test typical pattern scenario 

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA 
application Inbound processing for the typical pattern with input file having single business object. 

____ 1. Add the project to the WebSphere Test Environment server 

__ a. Right-click on WebSphere Process Server v6.1  under the Servers view and select Add and 
remove projects…  from the pop-up menu 

__ b. From the Add and Remove Projects window, select FTPTypicalInboundModuleApp  under 
Available projects panel and click Add >  

__ c. You will now see the FTPTypicalInboundModuleApp  added to the Configured projects  

__ d. Click Finish  and wait until the project is being published onto the server. The server is started in 
Debug mode if it is not already started before 

____ 2. Put the input files in the event directory 

Note : For your convenience, the test files SingleCustomerBO.xml , is placed in <FTPFILES>. 

__ a. On the machine where the FTP Server is running, put SingleCustomerBO.xml  file in the 
EventDir . The adapter will poll the copied file from the event directory and will transfer it to the 
archive directory 

__ b. The Customer BO is passed through the emitCustomerFile  method and you should see this 
message in the console (or SystemOut.log): 

 

____ 3. You can also verify the results by reviewing the archive directory 

__ a. Check the ArchiveDir  of your FTP server which should contain the same file name appended 
with year, month, date, system time, and processed 

__ b. Check the <LOCAL_ARCHIVE_DIR>  subdirectory which should contain an archive of the event 
files, with the same file name appended with year, month, date, system time, and success 

____ 4. Restore the Sever Configuration 

__ a. Right-click on WebSphere Process Server v6.1  under the Servers view and select Add and 
remove projects…  from the pop-up menu 

__ b. Select FTPTypicalInboundModuleApp  under Configured projects and click < Remove  

____ 5. Click Finish  after you see the application moved to Available projects. Wait until the application is 
being unpublished 
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What you did in this exercise 

In this lab, you started with importing the FTP File Adapter RAR file into your WebSphere Integration 
Developer new workspace. Then, you made use of the External Service wizard available in WebSphere 
Integration Developer to specify Activation Spec Properties, define data binding, data handler, and function 
selector which, after deploying onto the server, will generate business objects and other artifacts.  

At the end of each part, you deployed and then tested the adapter application for the scenarios - pass-
through (with and without SplitBySize) test scenario, two content specific or non pass through (with and 
without SplitByDelimiter) test scenarios, using all defaults (default data binding, function selector) scenario, 
and then finally using the typical pattern. 



© Copyright IBM Corporation 2008. All rights reserved 

IBM WEBSPHERE ADAPTER 6.1 – LAB EXERCISE 

2008 March, 27 IBM WebSphere Adapter 6.1 – Lab exercise Page 83 of 87 

 WBIV61_IEA_AdapterFTPInboundLab.doc 

Task: Adding remote server to WebSphere Integration  Developer test 
environment 

This task describes how to add a remote server to the WebSphere Integration Developer Test environment.  
This example uses a z/OS machine. 

Create a new remote server.  

____ 1. Right click on the background of the Servers view to access the pop-up menu. 

__ a. Select New > Server  

 

____ 2. Enter these from New Server window: 

__ a. In the New Server dialog, specify the remote server’s host name, <HOSTNAME> 
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__ b. Ensure that the appropriate server type, ‘WebSphere Process v6.1 Server ’ or ‘WebSphere 
ESB v6.1 Server ’, is highlighted in the server type list 

 

__ c. Click Next.  
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____ 3. On the WebSphere Server Settings page, leave the radio button for SOAP selected, changing the 
SOAP connector port  to the correct setting (<SOAP_PORT>).  If security is on in your server, 
check the box for ‘Security is enabled on this server’  and input <USERID> for the user ID and 
<PASSWORD> for the password. 

 

__ a. Click Finish . 
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____ 4. The new server should be seen in the Server view. 

 

____ 5. Start the remote server if it is not already started.   

Note : WebSphere Integration Developer V6.1 does not support starting remote servers from the Server 
View. So, you should start the remote server from the remote machine where the server is installed. 

__ a. From a command prompt, telnet to the remote system if needed (for z/OS or i5/OS): 

‘telnet <HOSTNAME> <TELNET_PORT> ’ 

 user ID :  <USERID> 

 password :  <PASSWORD> 

__ b. Navigate to the bin directory for the profile being used: 

 cd <WAS_HOME>/profiles/<PROFILE_NAME>/bin  

__ c. Run the command file to start the server:  ./startServer.sh <SERVER_NAME>  

__ a. Wait for status message indicating server has started: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ADMU3200I: Server launched. Waiting for initialization status 

ADMU3000I: Server cl1sr01 open for e-business; process id is 0000012000000002 
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